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A FEW WORDS ON PRINTING
What are specialty inks? 
Specialty inks o� er exciting capabilities that allows your designs to stand 
out. With specialty inks, a range of surface fi nishes can be achieved using 
inline print enhancements. Create eye-catching, impactful prints with the 
convenience of digital printing. 

We are proud to o� er the following specialty inks:

KODAK GOLD DRY INK—a luxurious, metallic gold ink that sparkles and 
commands attention.

KODAK DIMENSIONAL CLEAR DRY INK—a clear, 3-dimensional ink that adds a 
tactile experience on paper.

KODAK OPAQUE WHITE DRY INK—an incredibly dense opaque white ink that 
boosts your designs on coloured substrates.

KODAK METALLIC CLEAR DRY INK—a pearlized, transparent ink that simulates 
a wide range of metallic e� ects including silver.

KODAK CLEAR DRY INK—a clear ink that can create spot varnish e� ects or can 
also add fl ood protection to your project.

KODAK LIGHT BLACK HD DRY INK—Produces ultra-high-quality prints, 
particularly in areas of photography, neutral tones and in large fl at fi elds.

COLOUR GAMUT—Achieve a larger colour gamut and accurately match 97% 
of Pantone™ spot colours by using Red, Green or Blue Dry Ink in the Fifth 
Imaging Unit.

Apart from specialty, 5th unit inks, our NEXFINITY press is also capable of 
creating either regular or matte fi nishing. No fi le set up is required, just ask 
your salesperson about the matte fuser option.

What are “knockout” and “overprint”?
By default, artwork will appear opaque because the top colour “knocks” out or 
cuts out the layer of colour below it, if you have not changed the transparency 
of your artwork. This is described as “knockout” (see Figure 2).

To prevent knockout, you can change the transparency or overprint settings so 
the top colour prints over the colour underneath it. The resulting artwork will 
appear “blended”. This is described as “overprint” (see Figure 2).

Setting the transparency mode to “Multiply” tells the Digital Press to print the 
specialty inks on top of the colour image below, rather than hide it. You may 
view the separations preview panel in Adobe InDesign (see Figure 3).

Figure 1. Illustration of the Kodak NEXFINITY Digital Press (courtesy of Kodak)
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Direction paper travelsKodak NEXFINITY Digital Production 
Color Presses typically print four 
process colours—cyan, magenta, 
yellow, and black (a.k.a. CMYK). In 

addition, a fi fth imaging unit can 
print a variety of other NEXFINITY 
specialty inks (see Figure 1). This 
gives you the ability to add unique 
watermarks and protective coatings,  
match special colours, or add 
dimensional embellishments.

Figure 2. A visual representation of knockout and overprint
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How does digital printing with specialty inks work?



A FEW WORDS ON PRINTING
What are specialty inks? 
Specialty inks o� er exciting capabilities that allows your designs to stand 
out. With specialty inks, a range of surface fi nishes can be achieved using 
inline print enhancements. Create eye-catching, impactful prints with the 
convenience of digital printing. 

We are proud to o� er the following specialty inks:

KODAK GOLD DRY INK—a luxurious, metallic gold ink that sparkles and 
commands attention.

KODAK DIMENSIONAL CLEAR DRY INK—a clear, 3-dimensional ink that adds a 
tactile experience on paper.

KODAK OPAQUE WHITE DRY INK—an incredibly dense opaque white ink that 
boosts your designs on coloured substrates.

KODAK METALLIC CLEAR DRY INK—a pearlized, transparent ink that simulates 
a wide range of metallic e� ects including silver.

KODAK CLEAR DRY INK—a clear ink that can create spot varnish e� ects or can 
also add fl ood protection to your project.

KODAK LIGHT BLACK HD DRY INK—Produces ultra-high-quality prints, 
particularly in areas of photography, neutral tones and in large fl at fi elds.

COLOUR GAMUT—Achieve a larger colour gamut and accurately match 97% 
of Pantone™ spot colours by using Red, Green or Blue Dry Ink in the Fifth 
Imaging Unit.

Apart from specialty, 5th unit inks, our NEXFINITY press is also capable of 
creating either regular or matte fi nishing. No fi le set up is required, just ask 
your salesperson about the matte fuser option.

What are “knockout” and “overprint”?
By default, artwork will appear opaque because the top colour “knocks” out or 
cuts out the layer of colour below it, if you have not changed the transparency 
of your artwork. This is described as “knockout” (see Figure 2).

To prevent knockout, you can change the transparency or overprint settings so 
the top colour prints over the colour underneath it. The resulting artwork will 
appear “blended”. This is described as “overprint” (see Figure 2).

Setting the transparency mode to “Multiply” tells the Digital Press to print the 
specialty inks on top of the colour image below, rather than hide it. You may 
view the separations preview panel in Adobe InDesign (see Figure 3).

Figure 1. Illustration of the Kodak NEXFINITY Digital Press (courtesy of Kodak)

5

Direction paper travelsKodak NEXFINITY Digital Production 
Color Presses typically print four 
process colours—cyan, magenta, 
yellow, and black (a.k.a. CMYK). In 

addition, a fi fth imaging unit can 
print a variety of other NEXFINITY 
specialty inks (see Figure 1). This 
gives you the ability to add unique 
watermarks and protective coatings,  
match special colours, or add 
dimensional embellishments.

Figure 2. A visual representation of knockout and overprint

Knockout Overprint

Bottom layer

Final print

Top layer

Figure 3. Window > Output > 
Separations Preview

Separations Preview

View:   Separations 

CMYK
Cyan
Magenta
Yellow
Black
NexPress DryInk Gold

How does digital printing with specialty inks work?



1. Create new colour swatch
• Open your fi le in Adobe Illustrator or Adobe InDesign

• Go to Window > Swatches > New Color Swatch

• Set Swatch Name = “NexPress DryInk gold”; make sure to use this exact 
name, including capital letters and spaces (see Figure 1)

• Set Color Type = Spot

• Set Color Mode = CMYK

• Set CMYK = 0, 0, 100, 25

2. Edit opacity settings
• Select the objects you want to fi ll with gold

• Fill objects with the “NexPress DryInk gold” swatch 

• In Adobe Illustrator, go to Windows > Transparency OR 
In Adobe InDesign, go to Windows > E� ects 

• Set Blending Mode = 100% Multiply (see Figure 2)

• Save and export your artwork as a PDF fi le

Figure 1. Create a new colour swatch

Figure 2. Set opacity to “Multiply”
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NEXPRESS DRYINK GOLD
Stand out from the crowd with print that sparkles. Captivate 
your audience by adding metallic features to digitally-printed 
communications with NexPress DryInk gold.
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1. Convert images to greyscale
• Open your image in Adobe Photoshop

• Convert image to greyscale: Image > Mode > Grayscale

• Increase image contrast: Layer > New Adjustment Layer > Brightness/
Contrast (see Figure 3)

• Invert the image to ensure that the heaviest application of gold ink 
occurs in the lightest tonal areas: Image > Adjustments > Invert

2. Convert images to monotone
• Convert to duotone: Image > Mode > Duotone

• Set Type: Monotone (see Figure 4)

• Set Ink 1 CMYK = 0, 0, 100, 25

• Set Ink 1 Name = “NexPress DryInk gold”; make sure to use this exact 
name, including capital letters and spaces

• Save your fi le as “FileName–Gold.psd”

3. Edit opacity settings
• Open Adobe InDesign 

• If you wish to print gold exactly on top of the original colour image,

 ◦ Place your colour image on a new layer 

 ◦ Duplicate the layer and position it directly on top of the fi rst one

• Relink the top layer to FileName–Gold.psd

• Select the FileName–Gold.psd layer and set Blending Mode = 100% 
Multiply (see Figure 2)

• Complete the design

• Save and export your artwork as a PDF fi le
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Figure 3. Change image contrast

Figure 4. Convert to monotone

The gold e� ect varies depending on 
the fi ll colour of your text, and the tint 
% of gold applied over it. Usually, you 
want the heaviest gold application 
on the lightest areas.
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1    WORKING IN VECTOR

TI
PS

1. Convert images to greyscale
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Figure 3. Change image contrast
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1. Convert images to greyscale
• Open your image in Adobe Photoshop

• Convert image to greyscale: Image > Mode > Grayscale
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• Invert the image to ensure that the heaviest application of gold ink 
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1. Create new colour swatch
• Open your fi le in Adobe Illustrator or Adobe InDesign

• Go to Window > Swatches > New Color Swatch

• Set Swatch Name = “NexPress DryInk raised clear”; make sure to use this 
exact name, including capital letters and spaces (see Figure 1)

• Set Color Type = Spot

• Set Color Mode = CMYK

• Set CMYK = 0, 75, 100, 0

2. Edit opacity settings
• On a new layer, create vector objects you want to fi ll the specialty ink

• Fill objects with the “NexPress DryInk raised clear” swatch 

• In Adobe Illustrator, go to Windows > Transparency OR 
In Adobe InDesign, go to Windows > E� ects 

• Set Blending Mode = 100% Multiply (see Figure 2)

• Save and export your artwork as a PDF fi le
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NEXPRESS DRYINK RAISED CLEAR
The NexPress DryInk raised clear o� ers the ability to create 
added tactile impact for text, graphics and photos. Make a lasting 
impression on the readers with prints you can feel.
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1. Create new colour swatch
• Open your fi le in Adobe Illustrator or Adobe InDesign
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• Set Swatch Name = “NexPress DryInk raised clear”; make sure to use this 
exact name, including capital letters and spaces (see Figure 1)

• Set Color Type = Spot

• Set Color Mode = CMYK

• Set CMYK = 0, 75, 100, 0

2. Edit opacity settings
• On a new layer, create vector objects you want to fi ll the specialty ink

• Fill objects with the “NexPress DryInk raised clear” swatch 

• In Adobe Illustrator, go to Windows > Transparency OR 
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NEXPRESS DRYINK RAISED CLEAR
The NexPress DryInk raised clear o� ers the ability to create 
added tactile impact for text, graphics and photos. Make a lasting 
impression on the readers with prints you can feel.

1    WORKING IN VECTOR

TI
PS

1. Convert images to greyscale
• Open image in Adobe Photoshop

• Convert image to greyscale: Image > Mode > Grayscale

• Increase image contrast: Layer > New Adjustment Layer > Brightness/
Contrast (see Figure 3)

2. Convert images to monotone
• Convert to duotone: Image > Mode > Duotone

• Set Type: Monotone (see Figure 4)

• Set Ink 1 CMYK = 0, 75, 100, 0

• Set Ink 1 Name = “NexPress DryInk raised clear”; make sure to use this 
exact name, including capital letters and spaces

• Save your fi le as “FileName–RaisedClear.psd”

3. Edit opacity settings
• Open Adobe InDesign 

• If you wish to print dimensional clear ink exactly on top of the original 
colour image,

 ◦ Place your colour image on a new layer 

 ◦ Duplicate the layer and position it directly on top of the fi rst one

 ◦ Relink the top layer to FileName–RaisedClear.psd

• Select the FileName–RaisedClear.psd layer and set Blending Mode = 
100% Multiply (see Figure 2)

• Complete the design

• Save and export your artwork as a PDF fi le
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You can create textures using 
brushes such as natural, dry medium 
and special brushes. Brushes with 
harder edges result in more defi ned 
raised textures.
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1. Convert images to greyscale
• Open image in Adobe Photoshop

• Convert image to greyscale: Image > Mode > Grayscale

• Increase image contrast: Layer > New Adjustment Layer > Brightness/
Contrast (see Figure 3)

2. Convert images to monotone
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exact name, including capital letters and spaces

• Save your fi le as “FileName–RaisedClear.psd”

3. Edit opacity settings
• Open Adobe InDesign 

• If you wish to print dimensional clear ink exactly on top of the original 
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• Select the FileName–RaisedClear.psd layer and set Blending Mode = 
100% Multiply (see Figure 2)
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• Save and export your artwork as a PDF fi le
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NEXPRESS DRYINK OPAQUE WHITE
The ability to add opaque white ink into a design o� ers both 
practical and creative benefi ts. It boosts design uniqueness when 
incorporated into jobs printing on coloured substrates.

1. Create new colour swatch
• Open your fi le in Adobe Illustrator or Adobe InDesign

• Go to Window > Swatches > New Color Swatch

• Set Swatch Name = “NexPress DryInk opaque white”; make sure to use 
this exact name, including capital letters and spaces (see Figure 1)

• Set Color Type = Spot

• Set Color Mode = CMYK

• Set CMYK = 50, 0, 0, 50

2. Edit opacity settings
• On a new layer, create vector objects you want to fi ll the specialty ink

• Fill objects with the “NexPress DryInk opaque white” swatch 

• In Adobe Illustrator, go to Windows > Transparency OR 
In Adobe InDesign, go to Windows > E� ects 

• Set Blending Mode = 100% Multiply (see Figure 2)

• Save and export your artwork as a PDF fi le

Figure 2. Set opacity to “Multiply”
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NEXPRESS DRYINK OPAQUE WHITE
The ability to add opaque white ink into a design o� ers both 
practical and creative benefi ts. It boosts design uniqueness when 
incorporated into jobs printing on coloured substrates.
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1. Convert images to greyscale
• Open image in Adobe Photoshop

• Convert image to greyscale: Image > Mode > Grayscale

• Increase image contrast: Layer > New Adjustment Layer > Brightness/
Contrast (see Figure 3)

2. Convert images to monotone
• Convert to duotone: Image > Mode > Duotone

• Set Type: Monotone (see Figure 4)

• Set Ink 1 CMYK = 50, 0, 0, 50

• Set Ink 1 Name = “NexPress DryInk opaque white” (make sure to use this 
exact name, including capital letters and spaces, exactly as it appears)

• Save your fi le as “FileName–OpaqueWhite.psd”

3. Edit opacity settings
• Open Adobe InDesign 

• Place FileName–OpaqueWhite.psd on a new layer

• With the FileName–OpaqueWhite.psd layer selected, set Blending Mode = 
100% Multiply (see Figure 2)

• Complete the design

• Save and export your artwork as a PDF fi le
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We were one of the fi rsts to beta-test 
moving opaque white from the fi fth 
to the second unit of the press. This 
broadens the range of applications 
the press can produce.

Figure 5. White ink on black paper
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1. Convert images to greyscale
• Open image in Adobe Photoshop

• Convert image to greyscale: Image > Mode > Grayscale

• Increase image contrast: Layer > New Adjustment Layer > Brightness/
Contrast (see Figure 3)

2. Convert images to monotone
• Convert to duotone: Image > Mode > Duotone

• Set Type: Monotone (see Figure 4)

• Set Ink 1 CMYK = 50, 0, 0, 50

• Set Ink 1 Name = “NexPress DryInk opaque white” (make sure to use this 
exact name, including capital letters and spaces, exactly as it appears)

• Save your fi le as “FileName–OpaqueWhite.psd”

3. Edit opacity settings
• Open Adobe InDesign 

• Place FileName–OpaqueWhite.psd on a new layer

• With the FileName–OpaqueWhite.psd layer selected, set Blending Mode = 
100% Multiply (see Figure 2)

• Complete the design

• Save and export your artwork as a PDF fi le
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NEXPRESS DRYINK METALLIC CLEAR
Add shimmering e� ects of pearl with NexPress DryInk metallic 
clear. Use it to add visual impact to text and graphical elements 
or create the look of pearlized subtrates.

1. Create new colour swatch
• Open your fi le in Adobe Illustrator or Adobe InDesign

• Go to Window > Swatches > New Color Swatch

• Set Swatch Name = “NexPress DryInk metallic clear”; make sure to use 
this exact name, including capital letters and spaces (see Figure 1)

• Set Color Type = Spot

• Set Color Mode = CMYK

• Set CMYK = 50, 0, 0, 10

2. Edit opacity settings
• On a new layer, create vector objects you want to fi ll the specialty ink

• Fill objects with the “NexPress DryInk metallic clear” swatch 

• In Adobe Illustrator, go to Windows > Transparency OR 
In Adobe InDesign, go to Windows > E� ects 

• Set Blending Mode = 100% Multiply (see Figure 2)

• Save and export your artwork as a PDF fi le
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NEXPRESS DRYINK METALLIC CLEAR
Add shimmering e� ects of pearl with NexPress DryInk metallic 
clear. Use it to add visual impact to text and graphical elements 
or create the look of pearlized subtrates.

1. Create new colour swatch
• Open your fi le in Adobe Illustrator or Adobe InDesign

• Go to Window > Swatches > New Color Swatch

• Set Swatch Name = “NexPress DryInk metallic clear”; make sure to use 
this exact name, including capital letters and spaces (see Figure 1)

• Set Color Type = Spot

• Set Color Mode = CMYK

• Set CMYK = 50, 0, 0, 10

2. Edit opacity settings
• On a new layer, create vector objects you want to fi ll the specialty ink

• Fill objects with the “NexPress DryInk metallic clear” swatch 

• In Adobe Illustrator, go to Windows > Transparency OR 
In Adobe InDesign, go to Windows > E� ects 

• Set Blending Mode = 100% Multiply (see Figure 2)

• Save and export your artwork as a PDF fi le
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Figure 4. Convert to monotone

1. Convert images to greyscale
• Open image in Adobe Photoshop

• Convert image to greyscale: Image > Mode > Grayscale

• Increase image contrast: Layer > New Adjustment Layer > Brightness/
Contrast (see Figure 3)

2. Convert images to monotone
• Convert to duotone: Image > Mode > Duotone

• Set Type: Monotone (see Figure 4)

• Set Ink 1 CMYK = 50, 0, 0, 10

• Set Ink 1 Name = “NexPress DryInk metallic clear” (make sure to use this 
exact name, including capital letters and spaces, exactly as it appears)

• Save your fi le as “FileName–MetallicClear.psd”

3. Edit opacity settings
• Open Adobe InDesign 

• If you wish to print Metallic Clear exactly on top of the colour image,

 ◦ Place your colour image on a new layer 

 ◦ Duplicate the layer and position it directly on top of the fi rst one

 ◦ Relink the top layer to FileName–MetallicClear.psd

• Select the FileName–MetallicClear.psd layer and set Blending Mode = 
100% Multiply (see Figure 2)

• Complete the design

• Save and export your artwork as a PDF fi le
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NexPress DryInk metallic clear

When overprinted on another 
colour, Metallic Clear ink simulates 
a wide range of metallic e� ects 
including silver, bronze, copper, 
shimmery black and more.
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NEXPRESS DRYINK CLEAR
Opens the door to inline watermarking, spot or fl ood coating—
techniques similar to a spot or tinted matte varnish in o� set. 
Coating adds protection and enhances graphics and imagery.

1. Create new colour swatch
• Open your fi le in Adobe Illustrator or Adobe InDesign

• Go to Window > Swatches > New Color Swatch

• Set Swatch Name = “NexPress DryInk clear”; make sure to use this exact 
name, including capital letters and spaces (see Figure 1)

• Set Color Type = Spot

• Set Color Mode = CMYK

• Set CMYK = 75, 0, 100, 0
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• In Adobe Illustrator, go to Windows > Transparency OR 
In Adobe InDesign, go to Windows > E� ects 

• Set Blending Mode = 100% Multiply (see Figure 2)

• Save and export your artwork as a PDF fi le
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NEXPRESS DRYINK CLEAR
Opens the door to inline watermarking, spot or fl ood coating—
techniques similar to a spot or tinted matte varnish in o� set. 
Coating adds protection and enhances graphics and imagery.
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1. Convert images to greyscale
• Open image in Adobe Photoshop

• Convert image to greyscale: Image > Mode > Grayscale

• Increase image contrast: Layer > New Adjustment Layer > Brightness/
Contrast (see Figure 3)

2. Convert images to monotone
• Convert to duotone: Image > Mode > Duotone

• Set Type: Monotone (see Figure 4)

• Set Ink 1 CMYK = 75, 0, 100, 0

• Set Ink 1 Name = “NexPress DryInk clear” (make sure to use this exact 
name, including capital letters and spaces, exactly as it appears)

• Save your fi le as “FileName–Clear.psd”

3. Edit opacity settings
• Open Adobe InDesign 

• If you wish to print Clear exactly on top of the colour image,

 ◦ Place your colour image on a new layer 

 ◦ Duplicate the layer and position it directly on top of the fi rst one

 ◦ Relink the top layer to FileName–Clear.psd

• Select the FileName–Clear.psd layer and set Blending Mode = 100% 
Multiply (see Figure 2)

• Complete the design

• Save and export your artwork as a PDF fi le
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NexPress DryInk clear

For extra protection, clear ink can 
be used as a fl ood coat, covering 
the entire page. No fi le set-up 
is required, simply inform your 
salesperson to proceed. 
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Process Yellow

Process Black

Spot Plates

NexPress DryInk gold

Total Area Coverage

Simulation Profile:

Simulate Overprinting

Output Intent: ISO Coated v2 (ECI)

Output Preivew • Open the PDF in Adobe Acrobat

• Go to: Advanced > Print 
Production > Output preview

• Hover your mouse over the 
areas where you expect to have 
NexPress DryInk gold (or any 
other specialty inks)

• If you have set up the fi le 
correctly, the percentage of 
“NexPress DryInk gold” (or any 
other specialty inks) will change. 
100% being the highest possible

• NOTE: gold ink is represented 
visually by a mustard yellow 
overlay which will NOT be 
appear in the fi nal print

CHECKING YOUR PDF FILE
You have just prepared your artwork for specialty ink printing.
To check that you have prepared your fi le successfully, utilize 
Adobe Acrobat software and colour separations panel.
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CHECKING YOUR PDF FILE
You have just prepared your artwork for specialty ink printing.
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For detailed information about Kodak’s 
NEXFINITY Digital Press specialty ink printing, visit: 
https://www.kodak.com/en/print/product/digital/

fi fth-imaging-units/resources

RESOURCES

https://www.kodak.com/en/print/product/digital/
fifth-imaging-units/resources


For more assistance or information,  
please contact your Mitchell Press Expert.

mitchellpress.com | @mitchellprinters
604-528-9882 | info@mitchellpress.com  
8328 Riverbend Court | Burnaby, BC | V3N 5C9

For more assistance or information, 
please contact us at Mitchell Digital.

http://www.mitchellpress.com

